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ВВЕДЕНИЕ

Автоматизация проектирования радиоэлектронных устройств поз-
воляет существенно повысить производительность труда в этой об-
ласти, улучшить качество разработок. В настоящее время созданы 
и успешно используются системы, позволяющие автоматизировать 
все или большинство операций по сквозному проектированию ра-
диоэлектронных устройств: создание принципиальных схем, моде-
лирование, оценку характеристик проектируемого устройства, раз-
работку печатных плат, документирование результатов, подготовку 
управляющих программ для изготовления узлов устройства. К та-
ким программам относят, прежде всего, P-CAD, DesignLab, Micro-
Cap, Proteus, NI Multisim и др.

Эти пакеты содержат наборы (библиотеки) моделей элементов, 
источников сигналов, контрольно-измерительных приборов. Разра-
ботчик, как правило, с помощью мыши помещает нужные элементы 
в рабочее окно программы, соединяет их необходимым образом и 
запускает процесс динамического моделирования или симуляции 
(Simulate). Используя виртуальные приборы, пользователь может 
сформировать различные симулирующие (зондирующие) сигналы 
и оценить реакцию на них моделируемого устройства.

Результаты моделирования можно сохранить, дополнительно 
обработать в среде пакета или экспортировать в математические 
пакеты, электронные таблицы. Далее осуществляется разработка 
печатной платы, документирование результатов. Особо следует под-
черкнуть, что в большинстве случаев пользователь не имеет дела с 
традиционным программированием, то есть не составляет никаких 
инструкций. 

Одной из простых и легко осваиваемых программ, позволяющих 
проектировать как простые, так и сложные электромеханические, 
аналоговые и цифровые устройства, является упомянутая выше 
электронная система моделирования NI Multisim корпорации Na-
tional Instruments Electronics Workbench Group (http://www.ni.com/).

Программа имитирует рабочее место исследователя – лаборато-
рию с огромным набором элементов, оборудованную контрольно-из-
мерительными приборами, по внешнему виду, органам управления 
и характеристикам максимально приближенными к их промышлен-
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ным аналогам или даже являющимися их виртуальными копиями. 
Программа получила широкое распространение. Пакет могут ус-
пешно использовать как новички, так и профессионалы. Он дела-
ет процесс исследований более наглядным, готовит к проведению 
экспериментов в реальной лаборатории. Пакет является развитием 
известной программы Electronics Workbench.

В настоящее время издано несколько книг, в которых рассмат-
риваются возможности пакета Multisim, решение различных задач 
с его помощью, однако совершенствование и расширение функций 
пакета создают дефицит в таких работах. В справочнике приведено 
краткое описание основных функций версии программы NI Multi-
sim 10.1 и правил работы с ней. Автор не претендует на исчерпы-
вающее описание возможностей пакета и при его освоении считает 
целесообразным использовать и другие работы, в частности приве-
денные в библиографическом списке.

При подготовке издания использовались в основном справочные 
материалы разработчиков пакета, опыт проведения занятий по кур-
сам «Электроника и электронные элементы вычислительной тех-
ники», «Моделирование радиоэлектронных устройств» на кафедре 
вычислительной и прикладной математики Рязанского государс-
твенного радиотехнического университета. Справочник содержит 
семь разделов.

В первой главе рассматриваются элементы пользовательского 
интерфейса, описываются основные установки программы и пара-
метры создаваемых документов, которые следует определить перед 
началом работы для более эффективных действий.

Вторая глава содержит информацию по созданию и редактирова-
нию схем устройств. Несмотря на то, что эти процессы являются в 
большинстве случаев интуитивно понятными, материалы этого раз-
дела помогут пользователям более полно изучить и освоить возмож-
ности пакета. Предполагается, что читатели обладают знаниями, не-
обходимыми для разработки принципиальной схемы, прежде всего 
элементной базы, некоторым опытом разработки радиоэлектронных 
устройств. Этот раздел следует прочитать полностью, особенно на-
чинающим пользователям.

В третьей гдаве рассматриваются основные операции, выпол-
няемые при исследовании моделируемых устройств. Исследования 
обычно завершают работу разработчика – схемотехника (далее раз-
работку продолжают конструкторы), поэтому в этом разделе приве-
дены сведения по оформлению отчета.
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В четвертой и пятой главах кратко описаны приборы и методы 
исследований радиоэлектронных устройств. Успех исследований 
в значительной мере определяется знаниями методов анализа, на-
выками работы с приборами. К материалам этих разделов можно 
обращаться по мере необходимости, для изучения или уточнения 
особенностей работы с тем или иным прибором (методом), поэтому 
некоторая информация в них повторяется, а для упрощения поиска 
нужной информации четвертый и пятый разделы имеют большое 
число пунктов. Наиболее часто используемые приборы – мульти-
метр и осциллограф – рассмотрены более подробно, поэтому с их 
возможностями следует ознакомиться в первую очередь.

В шестой главе более подробно рассмотрены состав и характе-
ристики основных элементов, включенных в базовую версию пакета. 
К этому разделу следует обращаться при затруднениях с выбором 
нужного элемента. Большая часть библиотеки элементов – это мо-
дели конкретных электро- и радиотехнических элементов. Характе-
ристики этих приборов, следовательно и соответствующих моделей, 
определены технической документацией, и поэтому практически все 
параметры таких элементов «записаны» в моделях. Более подроб-
ную информацию об этих элементах можно найти в специальной 
литературе, на сайтах предприятий-изготовителей.

Значительное число моделей элементов создано специально для 
исследований в среде Multisim и, естественно, имеет ряд параметров, 
которые может определить пользователь. Существенное число пара-
метров, доступных пользователю, имеют и виртуальные элементы. 
В связи с этим большее внимание уделено моделям, разработанным 
для исследований в среде Multisim, и виртуальным элементам.

К материалам шестого раздела также следует обращаться по мере 
необходимости, для изучения или уточнения особенностей того или 
иного элемента, поэтому для того чтобы в одном месте получить, 
по возможности, полную информацию, пояснения некоторых пара-
метров повторяются, а для облегчения поиска нужной информации 
описания некоторых семейств выделены в отдельные разделы.

В последней, седьмой главе рассмотрен ряд примеров по исполь-
зованию пакета для анализа электрических цепей переменного тока, 
исследованию характеристик различных электронных устройств. 
Материалы каждого параграфа этого раздела содержат теорию, за-
дание на исследования и методику их проведения в среде Multisim. 
Все параграфы раздела являются самостоятельными. Материалы 
седьмого раздела помогут глубже освоить огромные возможности 
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пакета. Их можно использовать в качестве основы для лаборатор-
ного практикума.

Изучение программы NI Multisim 10.1 целесообразно проводить 
путем решения конкретных задач. При этом, по нашему мнению, не-
обходимо предварительно оценить свойства исследуемого устройс-
тва «вручную». Это, конечно, не означает, что все расчеты следует 
проводить на калькуляторе или бумаге, лучше для этого использо-
вать математические пакеты, в частности MathCAD. Перед модели-
рованием исследователь должен знать принципы работы исследуе-
мого устройства и, хотя бы ориентировочно, ожидаемые результаты. 
Моделирование должно подтвердить, уточнить, расширить знания 
об исследуемом устройстве, о процессах, происходящих в нем. Бо-
лее того, после моделирования желательна проверка исследуемого 
устройства, воплощенного в «железо».

Результаты исследований, полученные путем моделирования, как 
и все остальные, должны быть, если необходимо, дополнительно об-
работаны, полно и аккуратно оформлены. Пакет предоставляет для 
этого уникальные возможности: использование встроенных про-
грамм Grapher и Postprocessor.

Опыт использования программы в качестве основы для лабора-
торного практикума показывает, что на начальном этапе достаточно 
лишь предварительное ознакомление с ней. При последовательном 
усложнении исследовательских задач достаточно легко осваивают-
ся другие возможности уникального программного продукта. От-
метим, что на сайте представительства разработчика National In-
struments в России, СНГ и странах Балтии (National Instruments 
Russia, CIS & Baltic (http://digital.ni.com/worldwide/russia.nsf/
main?readform) размещено краткое учебное пособие по освоению 
основных функций пакета, а также ряд других документов.

Для успешного освоения пакета необходимы желание, настойчи-
вость и некоторые навыки работы на современных ЭВМ, в частнос-
ти опыт работы в среде Windows с каталогами и файлами, меню, 
панелями инструментов. Пользователь должен уметь пользоваться 
мышью, настраивать рабочую среду для себя. Разрешению проблем, 
возникающих в процессе работы, поможет справочная система паке-
та, в более сложных случаях – информация, размещенная в Интер-
нете. Упростит освоение системы знание английского языка.

Автор благодарит сотрудников Рязанского радиотехнического 
университета и представительства разработчика National Instruments 
в России, СНГ и Балтии, принявших участие в создании книги.
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Материалы книги многократно проверены. Тем не менее, тех-
нические ошибки практически неизбежны, поэтому автор с благо-
дарностью примет замечания, а также предложения, которые могут 
возникнуть у читателей книги, в первую очередь у студентов. Будем 
рады также узнать ваше мнение о работе. Отзывы можно направлять 
в издательство или автору по электронной почте – neon60@inbox.ru.
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Комплект программ NI Circuit Design Suite 10.0 National Instru-
ments включает Multisim – среду разработки и тестирования/эму-
ляции схем, Ultiboard – программу проектирования печатных плат 
и Multisim MCU Module – модуль для проектирования микропро-
цессорных устройств. Пакет содержит подробную инструкцию по 
установке, и при наличии некоторого опыта его инсталляция не 
вызывает трудностей, нужно последовательно выполнять команды 
диалоговых блоков.

Для работы требуются процессор Pentium III, не менее 256 MB 
оперативной памяти и 1 GB свободного пространства на жестком 
диске, видеоадаптер SVGA и монитор с разрешением не менее 
800×600. На компьютере должна быть установлена операционная 
система Windows 2000 (Service Pack 3) или Windows XP. Лучшие 
характеристики аппаратных средств, в первую очередь более быс-
тродействующий процессор, видеоадаптер и монитор с лучшими 
характеристиками, обеспечивают более комфортную работу. Запуск 
программы осуществляется традиционными способами, например, с 
помощью кнопки Пуск, затем команды Программы и т. д.

При описании приняты следующие условности. Выбрать или вы-
делить элемент, вкладку окна диалога, кнопку, поле ввода и др. – оз-
начает совместить с ними указатель мыши, затем нажать и отпустить 
(щелкнуть) левую кнопку мыши. Двойной щелчок – двукратное на-
жатие кнопки мыши, по умолчанию левой. Символ →, содержащий-
ся в перечисляемых командах, означает, что эти команды следует 
выполнять последовательно. Например, запись Tools → Database → 
Database Manager означает, что вначале выполняется команда Tools, 
затем Database и после этого Database Manager. Перечисление кла-
виш, соединенных символом +, означает, что они должны быть на-
жаты одновременно. В частности, нажав одновременно клавиши 
Ctrl+Esc, можно вызвать команду меню Пуск.

Практически все названия команд, окон диалога, кнопок, пере-
ключателей полей запроса и др. переводятся при первом упоми-
нании. В некоторых случаях переводы повторяются. Для лучшего 
воспроизведения наименований разделов или окон при печати на 
некоторых рисунках воспроизводится одновременно несколько ак-
тивных окон. Для этих же целей некоторые размеры окон диалога 
уменьшены (вырезано пустое место).
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1.1. Основные элементы 

пользовательского интерфейса

После запуска программы воспроизводится рабочее окно програм-
мы. Оно имеет вид, показанный на рис. 1.1. 

Рис. 1.1. Рабочее окно программы

Окно программы содержит традиционные компоненты: заголо-
вок, меню, панели инструментов, рабочее пространство или окно 
редактора, строку состояния. Основные процессы создания, редак-
тирования и анализа схемы производятся в окне редактора, поэтому 
под него отведено практически все пространство окна программы.

На рис. 1.1 в окне редактора воспроизводится схема сумматора 
по модулю два на элементах 2И–НЕ. К входу сумматора подклю-
чен генератор сигналов. Для анализа входного и выходного сигна-
лов используется двухлучевой осциллограф. Лицевые панели этих 
приборов также показаны на рис. 1.1.
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Заголовок документа  содержит имя проекта и имя схемы. В про-
стейших случаях они совпадают. Слева расположена вертикальная 
панель библиотеки элементов (базы данных (Component Bars)), 
справа – вертикальная панель приборов (Instruments). В нижней 
части окна отображаются вкладки открытых документов, причем 
если в документе не сохранены изменения, то имя документа и в за-
головке и на вкладке воспроизводится со звездочкой. Ниже пользо-
ватель может установить воспроизведение строки текущего состоя-
ния (Status bar), в которой отображаются команда, соответствующая 
выбранному инструменту, или выполняемая операция, индикаторы 
процесса моделирования и времени, прошедшего с начала модели-
рования (команда меню View → Statusbar).

Слева от основного окна может воспроизводиться окно проект-
ных инструментов (Design Toolbox), которое также называют менед-
жером проекта. С его помощью можно просто просматривать другие 
файлы проекта, иерархические структуры, управлять отображением 
(скрытием) различных атрибутов элементов. Кроме того, ниже стро-
ки состояния может воспроизводиться окно электронной таблицы 
(Spreadsheet View), на различных вкладках которой можно просмот-
реть результаты моделирования, поиска элементов, проанализиро-
вать и отредактировать параметры элементов схемы, цепей и др.

Все возможные функции и инструменты пакета реализуются че-
рез команды основного и контекстных меню, инструменты и горя-
чие клавиши. Значительная часть команд и инструментов, в час-
тности большинство команд меню File, Edit, View, Window, Help, 
инструментов по работе с файлами, редактированию, изменению 
масштаба, управлению моделированием, являются традиционной, и 
их действия предсказуемы. Специальные команды и инструменты 
будут рассмотрены при описании соответствующих действий поль-
зователя.

Для более эффективной работы после установки программы целе-
сообразно определить, соответствуют ли установки пакета, принятые 
по умолчанию, вашим требованиям, и при необходимости изменить 
их. В первую очередь, перед началом работы целесообразно настро-
ить элементы пользовательского интерфейса. Эта задача решается с 
помощью команды Options → Customize → User Interface, которая 
вызывает окно диалога Customize с пятью вкладками, позволяющи-
ми настроить элементы пользовательского интерфейса.

На первой вкладке (рис. 1.2) пользователь может определить на-
бор применяемых команд  – Commands. Для размещения команды 
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в том или ином пункте меню её следует выделить в правой части 
окна. Для поиска нужной команды следует выбрать режим воспро-
изведения определенной группы команд. После выделения команды 
(клавишу не отпускать!) указатель мыши принимает вид заштри-
хованного прямоугольника. Это изображение следует поместить в 
желаемое место желаемой команды (списки команд автоматически 
раскрываются при совмещении с командами главной строки меню). 
Для добавления инструмента на панель следует при открытом окне 
Customize выбрать пункт меню с соответствующей командой и ана-
логично поместить изображение прямоугольника в нужное место 
панели инструментов.

Рис. 1.2. Определение набора команд

На следующей вкладке пользователь может определить набор 
воспроизводимых панелей  инструментов – Toolbars. Для отображе-
ния панели достаточно сделать её активной – поставить «галочку» в 
прямоугольнике слева от названия панели, для удаления – сбросить 
«галочку». Панели инструментов можно расположить в различных 
местах документа, изменить их ориентацию. Для более оператив-
ного добавления (удаления) набора инструментов указатель мыши 
можно поместить на любую команду меню или любую панель инс-
трументов и нажать правую клавишу мыши. В раскрывшемся спис-
ке можно добавить или скрыть выбранную панель инструментов. 
Последняя команда в раскрывшемся списке позволяет вызвать окно 
диалога Customize.
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Вкладка Keyboard позволяет определить комбинацию горячих 
клавиш для любых команд, которые размещаются в меню или на 
панели инструментов (рис. 1.3).  Для этого достаточно выделить тре-
буемую команду и в окне Press New Shortcut Key (Новая комбина-
ция горячих клавиш) набрать (нажать) комбинацию клавиш и затем 
нажать кнопку Assign (Принять). В окне диалога на рис. 1.3 для 
изменения цвета выделенной цепи назначена комбинация клавиш 
Ctrl+Shift+C. Неудачно выбранную комбинацию можно выделить 
и удалить (кнопка Remove (Убрать)). Кнопка Reset All позволяет 
возвратиться в исходное состояние. При этом выводится сообщение 
о потере выполненных установок, с которым следует согласиться 
или его отклонить.

Рис. 1.3. Определение набора горячих клавиш

Набор команд для контекстных меню можно определить на вклад-
ке Menu. Здесь же можно установить метод вывода дополнительных 
меню (например, развертывающееся – Unfold, последовательно по 
строкам – Slide, плавно исчезающее изображение – Fade), воспро-
изведение команд меню с тенью – Shadows. Последняя вкладка 
Options позволяет изменить вид элементов пользовательского ин-
терфейса – например, воспроизводить большие значки, отображать 
для выбранного инструмента его наименование (действие), набор 
горячих клавиш.
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Программа Multisim имеет развитую систему помощи. Систе-
ма помощи имеет оглавление и многочисленные гиперссылки. На 
вкладках Указатель и Поиск можно проводить поиск с использо-
ванием ключевых слов. Актуальную для пользователя справочную 
информацию можно внести в раздел Избранное. Для отображения 
файлов помощи, в которых рассматривается работа пакета, следует 
использовать команду Multisim Help. Команда Component Reference 
позволяет вызвать файлы помощи с детальным описанием элемен-
тов принципиальных схем. Для вызова контекстной помощи следует 
воспользоваться клавишей F1 или кнопкой Help в окнах диалога. 
В достаточно большом числе окон помощи предлагается обратить-
ся за технической поддержкой через Интернет непосредственно на 
фирму разработчиков пакета – Visit Our Website.

1.2. Определение свойств пакета

Параметры работы с пакетом можно определить, выбрав последо-
вательно команды Options → Global Preferences (Свойства пакета ). 
Открывшееся окно Preference содержит четыре вкладки. В окне 
вкладки Paths (Каталоги) (рис. 1.4) следует установить полное имя 
(путь) рабочего каталога (Circuit default paths), который предлага-
ется пакетом по умолчанию для хранения файлов исследуемых схем 
(или согласиться с предлагаемым).

В следующем разделе окна диалога нужно определить место хра-
нения графических материалов (User button images path), а ниже – 
место хранения файла конфигурации системы. Кроме того, следует 
также указать места расположения основной (Master database) и 
других, дополнительных, не поставляемых вместе с системой, кор-
поративной и пользовательской библиотек элементов (Corporative, 
User Database). Эти установки становятся действующими при пе-
резапуске программы.

Наконец, если имеется возможность, то следует выбрать язык 
 интерфейса (Language). Отметим, что на сайте представительства 
фирмы разработчика National Instruments в России, СНГ и странах 
Балтии (National Instruments Russia, CIS & Baltic – www.ni.com.ru) 
размещен русификатор пакета. К сожалению, перевод некоторых, 
как правило неочевидных, команд и опций в окнах диалога не осу-
ществлен, также не переведен и Help. Поэтому, по нашему мнению, 
лучше пользоваться оригинальной англоязычной версией.
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Рис. 1.4. Вкладка Paths диалогового окна Свойства пакета

В следующем окне диалога с вкладкой Save (Сохранить) (рис. 1.5) 
можно установить:

• создание резервной копии  документа (Create a Security Copy), 
в которой сохраняются последние изменения. Её можно ис-
пользовать при различных нестандартных (аварийных) ситу-
ациях;

• автосохранение файла с интервалом (Auto-backup), указанным 
в окне Auto-backup interval;

• сохранение принципиальной схемы документа вместе с ре-
зультатами моделирования, отображаемыми на приборах (Save 
simulation data with instruments). Это позволяет сопоставлять 
модификации схемы и результаты исследований, полученные 
в различных сеансах работы с пакетом без повторного модели-
рования. Так как процесс моделирования может занимать дли-
тельное время и для анализа могут использоваться несколько 
приборов, то устанавливается максимальный размер сохраня-
емого файла. 
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Допустимый размер файла устанавливается в поле Maximum 
size. При превышении установленного размера пакетом формирует-
ся дополнительный запрос об операциях пользователя с данными, 
превышающими установленный размер. Кроме того, здесь же мож-
но определить кодировку текстовых файлов, в которых сохраняют 
сообщения пакета.

На вкладке Parts (Способ работы) (рис. 1.6) в блоке Place compo-
nent mode выбирается режим  размещения элементов. Пользователь 
может установить режим возвращения к библиотеке элементов пос-
ле расположения элемента в окне редактора (Return to Component 
Browser after placement), установив «галочку» против указанной 
команды. В противном случае повторное обращение к библиотеке 
элементов проводится пользователем с помощью команд меню, инс-
трументов или горячих клавиш.

Далее следует выбрать один из методов работы: размещать единс-
твенный элемент (Place single component), непрерывно размещать 
многосекционные элементы (Continuous placement for multi-section 
part only), непрерывно размещать любые элементы (Continuous). 

Рис. 1.5. Вкладка Save диалогового окна Свойства пакета
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